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Download and Installation Instructions
for

Android SDK and Android Development Tools (ADT)

on
Microsoft Windows

Updated October, 2012

This document will describe how to download and install the Android SDK and Android

Development Tools (ADT) into your programming environment.

Before continuing, be sure that your computer already has the |DK and Eclipse software installed. You can find

instructional documentation for these steps if needed from your Student Menu or in your “Installation Docs” directory.

The TeenCoder™: Android Programming course adds three pieces of free software to your existing JDK
and Eclipse development environment: the Android Software Development Kit (Android SDK),
the Android Development Tools (ADT) for Eclipse, and the Android Google APIs. These pieces

of software will enable you to write and test Android applications without any Android hardware!

This software is required for students in order to complete the course. Teachers who wish to view

activity solutions or projects on their own computer are also encouraged to install this software.

Copyright Notices:

Java, Java Development Kit (]DK) and related terms are all copyright by Oracle Corporation. Please see

http://www.oracle.com for more details. Ec/jpse and related terms are copyright by the Eclipse
Foundation. Android, Android Software Development Kit, and Android Development Tools and related terms
are all copyright by Google, Inc.

This document, TeenCoder™: Java Programming, TeenCoder™: Android Programming and related terms
are copyright by Homeschool Programming, Inc. This document may not be transmitted or

reproduced without written permission except under terms of your purchased course license.

Disclaimer:

Homeschool Programming, Inc, and their officers and shareholders, assume no liability for damage
to personal computers or loss of data residing on personal computers arising due to the use or
misuse of this course material. Always follow instructions provided by the manufacturer of 3rd party

programs that may be included or referenced by our courses.
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Let’'s Get Started!

You will need access to the Internet in order to complete the installation process. Some downloads
are very large (100MB+) so plan time based on the speed of your Internet connection. Note that all

red highlights below are added for emphasis and are not present on the actual screens.

Android components are evolving rapidly! This course is based on the Eclipse ADT version 16,
Android SDK version 16, Android Platform Tools version 10, The Android Platform version 2.3.3
(10), and the Google APIs version 10. Newer software levels are likely available by the time you
begin this course, but we recommend for the smoothest possible learning experience that you
stick with our original component versions.

Should you choose to instead obtain the latest Android versions, please skip to the next chapter
titled “Installing the Latest Android Versions” and follow those instructions instead. Be aware that
some screen shots may no longer match our examples exactly, and some Android functions we
describe in the course may change over time. You will be responsible for understanding and

overcoming those differences if you choose the latest Android versions!
Downloading the Original Course Android Bundles

We have created ZIP “bundles” of the Android components at the original course versions that you
can download from our website. This procedure replaces a standard Eclipse-based approach that

will only allow you to download the very latest Android software components.

To begin, run Windows Explorer and create a folder on your hard drive where the Android SDK
and other components will be installed. We recommend the directory name “C:\android-sdk”

though you may choose another location.

@U;" -« Local Disk (C:) » andraid-sdk ~ | 3 || search android-sax )
Organize = Include in library - Share with - Mew folder = ~ [ i@]
4 £, Local Disk (C3) = Mame . Date modifie
. android-sdk

This folder is ermphy.
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Next, launch your web browser (Internet Explorer, Firefox, Chrome, etc.) and download the
following two ZIP files. You can type these addresses directly into your web browser, or navigate to

the links from our “Support = Document Updates” page at www.HomeschoolProgramming.com.

http://www.homeschoolprogramming.com/downloads/ADT-16.0.1.zip (approx. 7 MB)

‘@Computer prograrmming for kids and te.., | + ‘

& % ( http:h‘\n-'\mw.homeschoolprogramming.cDm,’dnwnIuadsf.ﬂ.DT—lﬁ.El.l.ziplJ > &% B -

http://www.homeschoolprogramming.com/downloads/android-sdk-windows.zip (approx 188 MB)

‘@'Computer programiming for kids and te... | + ‘

= % ( hitkpef fwnineichormeschoolprograrming.corm/fdovenloads/android-sdk-windows.zip r )ﬁ‘ ﬂ" & -

Depending on your web browser and configuration, you may be prompted for a target download
location on your local hard drive, or the ZIP file may be automatically saved to a download folder.
Choose your newly created “C:\android-sdk” as your target folder if possible. If the ZIP files are
automatically saved to some other folder, then simply copy them over to “C:\android-sdk” when

the download is complete.

When the downloads are complete you should have the “android-sdk-windows.zip” and “ADT-
16.0.1.zip” files in your “C:\android-sdk” directory

(=] & |wES)

@Uv| ;= Local Disk (C) » android-sdk - | 4 | | Segrch android-sdi ju |
Organize = Include in library - Share with - Mew folder =~ O [ﬁl
4 £, Local Disk (C3) = Mame . Date modifie
. android-sdk g.&DT-lﬁ.ﬂ.l.zip

E android-sdk-windows.zip

- 4 [a T b

http://www.HomeschoolProgramming.com Page 3


http://www.homeschoolprogramming.com/
http://www.homeschoolprogramming.com/
http://www.homeschoolprogramming.com/downloads/ADT-16.0.1.zip
http://www.homeschoolprogramming.com/downloads/android-sdk-windows.zip

Copyright 2012 by Homeschool Programming, Inc.

Next, un-zip the “android-sdk-windows.zip” package to the same directory. To unzip the Android
SDK on Windows 7 you can simply right-click on the file in Windows Explorer and select “Extract
All...”, and type in the “C:\android-sdk” as the destination folder, then click “Extract”.

' =)

‘o) 1) Extract Compressed (Zipped) Folders

Select a Destination and Extract Files

Files will be extracted to this folder

Y
( Chandroid-sdk J Browse..,

Show extracted files when complete

() o

If you have an older version of Windows or have installed some other 3* party ZIP management

program such as WinZip or PKZip then your extraction process will be slightly different. When you
are finished, the “C:\android-sdk” directory should contain many sub-folders and files.

Fo

= e 5
@Uv| ;0 Local Disk (C) » android-sdk » - | 3 | | Segrch android-sdk 2 |
Organize = Include in library - Share with = Mew folder 3=« [ i@l
it Marne . Date modified
1 Libraries E|
N . add-ons 978/2012 1:48 P
. | platforms 9782012 2:06 PR
M Computer
—~ ] J platform-tools 97852012 1240 PR
few Local Disk (T2
| tools 978/2012 1:35 P
. android-sdk
RLE B A0T-16.0.17ip 9/8/2012 1:21 PM
g android-sdk-windows.zip 978,/2012 2:08 PRA
A0 Manager,exe 982012 1235 PA
DK Manager,exe 982012 1235 PA
| SDK Readme.tzt 0/8/2012 1:35 PhA
- 4 1 F
9 iterms
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Installing the Eclipse ADT Version 16

To install the Eclipse Android Development Tools, open your Eclipse software and click on the

“Help” menu item at the top of the screen. In the Help menu, find and click on the item called

“Install New Software”.

Once you click on the “Install New Software” item, you will see the Installation screen for available

software.
= Install

Available Software

Select a site or enter the location of a site.

e
7
D) -

Work with:e type or select a site|

type filter text

Mame Version

[[1 @ There is no site selected.

Select All | [ Deselect Al

Details

Show only the latest versions of available software [ Hide items that are already installed

[¥] Group items by category What is already installed?
[] Show only software applicable to target environment

[¥] Contact all update sites during install te find required software

Find more software by working with the "Available Software Site

Finish

Cancel

On this screen, you will need to click on the “Add” button that is circled in the upper-right corner

of the screen. This will bring up the “Add Repository” screen seen below. Here, you will enter the

e "

= Add Repositary @

Marme: I .ﬁ.ndrnid.-'lD'I'l l Lacal...
http: sy ( Erchive,.,

Location:

0 o

name

“Android

ADT” and click on
the

button.

“Archive...”
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Browse to your “C:\android-sdk” folder, select the “ADT-16.0.1.zip” file, and click “Open”.

-

= Repository archive :l
— rl %
@U'| J <tL|:u:aI Disk (C:) » android-sdk » J - |4'r;+ | | Segrch android-sdi; ju l
Organize - Mew folder = >~ [ﬁl
Marme Date rme
Libraries
o B ADT-16.0.17ip 9/8/201
: E android-sdk-windows.zip aras201
M Computer
£, Local Disk (C3)
a Data (D2
] ] b
File namg: ADT-16.0.1zip - ’*.jar;*.zip v]
[ Qpen ] [ Cancel ]

Your Add Repository dialog should now have a complete Location path to your local ZIP file, so

click “OK” to continue.

o

= Add Repositary

Mame: Android ADT

Location:  jarfile:/Cifandroid-sdk AADT-16.0.1.zip!lf

-

Archive...

[

® (

]] Cancel |
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The next screen will show you the “Available Software” items for the ADT plug-in. Make sure there

is a check mark in the “Developer Tools” box and then click on “Next”.

= Install = @
Available Software
Check the iterns that you wish to install,

Work with:  Android ADT - jarfile/Cifandroid-sdk/ADT-16.0.Lziplf - Add...

Find more software by warking with the "&ovailable Software Sites” preferences,

type filter text

Marme YWersion

4 [ 000 Peveloper Toals

[t Android DDMS 16.0,14201112150204-238534
i Android Developrment Tools 16.0.1201112150204- 238534
i Android Hierarchy Wiewer 16.0.1.201112150204-238534
[+ Andraid Traceview 16.0,142011124150204-238534
Select Al | | Ceselect All | Iditer‘ns selected I
Details
| Showe anly the latest versions of available software Hide iterns that are already installed
J| Group iterns by category What is already installed?

Shovy only softweare applicable to target environment

J| Contact all update sites during install to find required software

P —_—
@ <ooc{[tmaz] | rer Canca
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The next screen will display a list of items that the Eclipse system is about to install. You should see
items similar to the list seen below. To continue the installation, just click on the “Next” button at

the bottom of the screen.

& Install e e

Install Details

Review the iterns to be installed.

w

Mame Version Id
4+ Android DDMS 16.01.,2011121502... com.android.ide.eclipse
@ Android Development Tools 16.01.x2011121502... com.android.ide.eclipse
i+ Android Hierarchy Viewer 16.01.:2011121502... com.android.ide.eclipse
i+ Android Traceview 16.01.:2011121502... com.android.ide.eclipse
1| 1] 3

Size: Unknown
Details

3
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At this point, you are given an opportunity to review the license agreement for using the ADT

software. You can review this agreement if you wish, and then choose the radio button that says “I

accept the terms of the license agreements” and click on the “Finish” button at the bottom.

.
= Install

B

Review Licenses

Licenses:

Licenses must be reviewed and accepted before the software can be installed.

Apache License
Eclipse Foundation Software User Agreement

4 I

Mote: jeommon-1.012,jar is under the BSD license rather than the
Mote: koanl2-2.3.0.5ar is under the BSD license rather than the EPL.

o

License text:

Apache License
Version 2.0, January 2004 |

http://www.apache.org/licenses/

TERMS AMD COMDITIONS FOR USE,
REPRODUCTION, AND DISTRIBUTION

1. Definitions.

@) 1 accept the terms of the license agreements:
Tense agreements

©)

Mext > [ Einish) Cancel ]
SN

Now the ADT software will begin to install from your local “ADT-16.0.1.zip” file. This process can

take a few minutes.

= Installing Software

Installing Software

[I:Always run in background:

I?I@

Fetching org.eclipse.emf.edit_2.7.1.v201109...ases/indigo,/201109230900//aggregate/plugins/

Run in Ear_kgroundl ’ Cancel ] [ Details ==
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At some point in the download and installation, you may see a warning window like this one:

= Security Warning = @

Warning: You are installing software that contains unsigned content. The authenticity
l . or validity of this software cannot be established. Do you want to continue with the
installation?

oK || cCancel || Details>>

If you do see this message, you can just click on “OK” and continue the download and installation.

Once the download and installation is complete, you will see the following message:

I "~

= Software Updates ==

You will need to restart Eclipse for the installation changes to take effect. You may try
to apply the changes without restarting, but this rmay cause errors,

Restart Mow ] ’ Mot Mow l lﬂpply Changes Mow

Click “Restart Now”. This will restart just the Eclipse software, not your whole computer!

You have completed the installation of the Eclipse Android Development Tools (ADT). After
restarting Eclipse you can continue to the next step: Configuring the Android SDK.
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Configuring the Android SDK after Restart

When restarting your Eclipse software after installing the Android ADT, you should be presented
with a Welcome dialog that allows you to install or configure the Android SDK. If you do not see
this welcome dialog, please skip to the next section titled “Configuring the Android SDK Location
Manually”.

Since we have already downloaded and unzipped the android SDK, we simply need to point Eclipse
to that directory. Click on “Use existing SDKs” and type in “C:\android-sdk” to the Location field.
Then click “Next”.

= Welcome to Android Development = @

Welcome to Android Development
Configure SDK

To develop for Android, you need an Android 50K, and at least one version of the Android APIs to compile
against. You may also want additional versions of Android to test with,

[]Inztall the latest available version of Android APIs (supports all the latest features)
[ Install Android 2.1, a version which is supported by ~87% phones and tablets
(You can add additional platforms using the SDK Manager.)

Target Location:

(0:' Use existing SDKS)

Existing Location: I Chandroid-sdk l Browse...

o
h?,' < Back Mext = Einish

=]
(=1}
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The final screen may ask if you wish to contribute usage statistics to Google. You can select “No”

and then click on “Finish”.

= ‘Welcorne to Android Developrnent = @

Contribute Usage Statistics?

We know wou just weant o get started but please read this first,

By choosing to send certain usage statistics to Google, wou can help us improve the Android SDE These usage
statistics lets us measure things like active usage of the SDE, and let us know things like which wersions of the
DK are inuse and which tools are the most popular with developers. This limited data is not associated with
persanal infarmation about you, and is exarnined an an aggregate basis, and is maintained in accordance with
the Google Privacy Policy.

Send wsage statistics to Google?
Yes

If wou later decide to change this setting, wou can do so ik the options panel under Android > Usage Stats
Google Privacy Paolicy

= ———
'\‘?J' % Back Mext = [ Finish l | Cancel

Congratulations! You have completed the installation for the Android ADT, Android SDK, and

supporting components. You are now ready to begin your Android development.

You do not need to continue to the next section.

Configuring the Android SDK Location Manually

If you do not see the “Welcome” dialog when restarting Eclipse, or you are notified that you need to
configure a valid Android SDK path, you can configure the Android SDK location manually. To do
this, from Eclipse, select the “Window = Preferences” option from the menu, and then click on the
“Android” entry in the left pane. Enter your target SDK path “C:\android.sdk” in the top field and
click “OK”.
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= Preferences = @

type filter text Android - v w

B E -~

Android Preferences i
At SDK Location: | Cihandroid-sdk| ‘M

Help Mote: The list of 30K Targets below is anly reloaded once you hit "Bpply' or 'Ok,
Install/pdate =

lava Target Marme Wendar Platforrm  APL., | |5
Mawen Android 2.3.3 Android Open Source Project 2.3.3 10

Mylyn Google APTs Google Inc. 233 10
Run/Debug

Team

IUsage Data Collector
Walidation

C’E':l [ 0] ] Cancel

Congratulations! You have completed the installation for the Android ADT, Android SDK, and

supporting components. You are now ready to begin your Android development.

You do not need to continue to the next section.
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Installing the Latest Android Versions (Alternative Procedure)

If you have successfully downloaded and installed the Android bundle containing the original course
versions of the Android SDK, ADT Tools, and Google APIs, then you do not need to complete
these steps. You are already finished! If you skipped the bundle download and would prefer instead

to install the latest versions of the Android components, follow the procedure below.
Downloading and Installing the Android Development Tools

In order to prepare your development environment for Android programming, you will need to
install both the Android Development Tools for Eclipse (also called the ADT Plugin) and the
Android Software Development Kit (also called the Android SDK). Both of these additional
packages can be installed directly from your

Eclipse IDE software.

To begin the installation process, open your |idal Welcome
Eclipse softwate and click on the “Help” menu | 3} Help Contents
item at the top of the screen. In the Help menu, @ Search

find and click on the item called “Install New Dynamic Help
Software”. _ :
Key Assist.., Ctrl+5Shift+L
Tips and Tricks...
4 Report Bug or Enhancement...
Cheat Sheets...

Install Mew Software...
Eclipse Marketplace...

About Eclipse
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Once you click on the “Install New Software” item, you will see the Installation screen for available

software.
= Install

Available Software

Select a site or enter the location of a site.

e

Work With:6 type or select a site|

[] Show only software applicable to target environment
[¥] Contact all update sites during install to find required software

Find more software by working with the "Available Software Site

type filter text
MName Wersion
[[1(@ There is no site selected.
Select All | [ Deselect Al
Details
Show only the |atest versions of available software ["]Hide itemns that are already installed
[¥] Group items by category What is already installed?

On this screen, you will need to click on the “Add” button that is circled in the upper-right corner

of the screen. This will bring up the “Add Repository” screen seen below. Here, you will enter the

name “Android ADT” and a location “https://dl-ssl.google.com/android/eclipse/”. Then you can

click “OK”.

= Add Repository

MName: Android ADT

-

(3]

Lecation:  https://dl-ssl.google.com/android/eclipse

Archive...

@ oK

|| cCancel |

http:/ /www.HomeschoolProgramming.com
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The next screen will show you the “Available Software” items for the ADT plugin. Make sure there

is a check mark in the “Developer Tools” box and then click on “Next”.

= nstall l = |-
Available Software

Check the items that you wish to install, :).TJ

Work with:  ADT Plugin - https://dl-ssl.google.com/android/eclipse/ -

Find more software by working with the "Available Software Sites” preferences.

type filter text

Version
eloper Tools
Android DDMS 16.0.1.»201112150204-238534
Android Development Tools 16012011121 50204 -238534
g4k Android Hierarchy Viewer 16.01.v201112150204 -238534
- Android Traceview 16.0.1.v201112150204-238534

1 | (1] 3

[ Select Al ] [ Deselect Al 4 items selected

Details

Show only the |atest versions of available software [T Hide items that are already installed
[¥] Group itermns by category What is already installed?

[] Show only software applicable to target environment

[V] Contact all update sites during install te find required software

?) ini
CJ < Back Mext = Einish

NOTE: By the time you are installing on your computer, there will be higher “Version” numbers
available. By following this procedure you are choosing to install the latest versions instead of the

original levels used to create this course.

http://www.HomeschoolProgramming.com Page 16


http://www.homeschoolprogramming.com/

Copyright 2012 by Homeschool Programming, Inc.

The next screen will display a list of items that the Eclipse system is about to install. You should see
items similar to the list seen below. To continue the installation, just click on the “Next” button at

the bottom of the screen.

& Install e e

Install Details

Review the iterns to be installed.

w

Mame Version Id
4+ Android DDMS 16.01.,2011121502... com.android.ide.eclipse
@ Android Development Tools 16.01.x2011121502... com.android.ide.eclipse
i+ Android Hierarchy Viewer 16.01.:2011121502... com.android.ide.eclipse
i+ Android Traceview 16.01.:2011121502... com.android.ide.eclipse
1| 1] 3

Size: Unknown
Details

3
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At this point, you are given an opportunity to review the license agreement for using the ADT
software. You can review this agreement if you wish, and then choose the radio button that says “I
accept the terms of the license agreements” and click on the “Finish” button at the bottom.

[ =] | S

= Install

Review Licenses
D 3
-]

Licenses must be reviewed and accepted before the software can be installed. =
Licenses: License text:
Apache License Apache License -
Eclipse Foundation Software User Agreement Version 2.0, January 2004 [
http://www.apache.org/licenses/

Mote: jeommon-1.012,jar is under the BSD license rather than the

Mote: koanl2-2.3.0.5ar is under the BSD license rather than the EPL. TERMS AND CONDITIONS FOR USE,
REPRODUCTION, AND DISTRIBUTION

1. Definitions.

@) 1 accept the terms of the license agreements:
Tense agreements

4 I

@:‘ Mext > [ Einish) Cancel ]
SN

Now the ADT software will begin to download from the Internet. Depending on the speed of your

Internet connection, this process can take a few minutes.

o -5 ]

= Installing Software

-

Installing Software

Fetching org.eclipse.emf.edit_2.7.1.v201109...ases/indigo,/201109230900//aggregate/plugins/

[I:Always run in background:

Run in Ear_kgroundl ’ Cancel ] [ Details ==
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At some point in the download and installation, you may see a warning window like this one:

= Security Warning ?@

Warning: You are installing software that contains unsigned content. The authenticity
l . or validity of this software cannot be established. Do you want to continue with the
installation?

oK || cCancel || Details>>

If you do see this message, you can just click on “OK” and continue the download and installation.

Once the download and installation is complete, you will see the following message:

I "~

= Software Updates ==

You will need to restart Eclipse for the installation changes to take effect. You may try
to apply the changes without restarting, but this rmay cause errors,

Restart Mow ] ’ Mot Mow l lﬂpply Changes Mow

Click “Restart Now”. This will restart just the Eclipse software, not your whole computer!

Congratulations! You have completed the installation of the Eclipse Android Development Tools
(ADT). After restarting Eclipse you can continue to the next step: Installing the Android SDK.

Downloading and Installing the Android SDK

Now that we ADT Plug-in for Eclipse is installed, you are half-way there! The next step we need to
take is to install the Android Software Development Kit, or Android SDK. We can also complete
this process from within the Eclipse software. In fact, when Eclipse re-starts after the ADT install,

the Android SDK installation process should start automatically with the following screen:
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= Welcome to Android Development (=] @

Welcome to Android Development
Configure SDK

Teo develop for Android, you need an Andreid 50K, and at least one version of the Android APIs to compile
against. You may also want additional versions of Android to test with.

nstall the latest available version of Android APIs (supports all the latest features)
Install Android 2.1, a version which is supported by ~97% phones and tablets
(You can add additional platforms using the SDK Manager.)

Target Location:  Chandroid-sdks Browse...

Use existing SDKs

Existing Location: B rowse

-
b,
[[=5]
1
=
W

nish | Cancel

At this point, you can have the Eclipse software automatically download and install the Android
SDK. Make sure that the radio button controls marked “Install new SDK” is selected and check the
box for “Install the latest available version of Android APIs...”. You can leave the default “Target
Location” as “C:\android-sdks” unless you wish to change it. When you are ready, click on the

“Next” button to continue.

Note: If you do not see this screen, or if you accidentally “Cancel” this screen instead of
hitting the “Next” button, you will need to manually install the Android SDK. For
instructions on this process, please skip to the section later in this document titled
“Manually Installing the Android SDK?”.
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The next screen will ask you if you want to participate in the collection of Usage Statistics for the
Android SDK. You can decided if you want to participate in this program, but we recommend

selecting the “No” radio button. When you are ready, click on the “Finish” button to continue.

= Welcome to Android Development (=] @

Contribute Usage Statistics?
We know you just want to get started but please read this first.

By choosing to send certain usage statistics to Google, you can help us improve the Android SDK. These usage
statistics lets us measure things like active usage of the SDK, and let us know things like which versions of the
5DK are in use and which tools are the most popular with developers. This limited data is not asscciated with
personal information about you, and is examined on an aggregate basis, and is maintained in accordance with
the Google Privacy Policy.

Send usage statistics to Google?
Yes

If you later decide to change this setting, you can do so in the options panel under Android > Usage Stats
Google Privacy Policy

= ——
':i,' | < Back Mext = ) Cancel

At this point, the Android SDK Manager will retrieve a list of possible packages that will be

downloaded during the installation process.

o -

Sndroid 50K Manager EI@

.

Fetching URL: https://dl-ssl.google.com/android/repository faddon.xml
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The installation process will determine which SDK items will be downloaded and installed and then
will ask you to “Accept” the license agreements for these components. Choose the “Accept All”

radio button and then click on the “Install” button.

= Choose Packages to Install I. =l i:-?-l

Packages Package Description & License
Android SDK Tools, revision 16 [*] Package Description -
Android SDK Platform-tools, revision 10 [*] Android 5DK Tools, revision 16

SDK Platform Android 4.0.3, API15, revision 2

m

Dependencies
Installing this package also requires installing:

- Android SDK Platform-tools, revision 10 =

This package is a dependency for:
- SDK Platform Android 4.0.3, API15, revision 2

(71 Accept () Reject

At this point, the SDK will be downloaded from the Internet and installed on your computer. This
process can take anywhere from a few minutes to 10 minutes or more, depending on the speed of

your Internet connection.

F. =

| Android SDK Ma nager @

—_— | —
Downleading Android 50K Tools, revision 16 (43%, 321 KiB/s, 50 seconds left)
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Once the progress bar dialog disappears, you will see the following messages in the “Console”

window in Eclipse:

& Java - Eclipse =T

Eile Edit Bun Sowrce Mavigate Search Project Refactor Window Help

C-m§~ AE B BSd $-0-Q- #HG~ 5 (@)
o =T - - - -
TSN = O/ 8] TaskList 22 =
IR
(I} Connect Mylyn 52

Connect to your task and ALM tooks
or create a local task.

[£! Problems | @ Javadoc [, Declaration| B Console i3 et B-r9~-=0
Lndroid

[PULL-WZ B4 LETEEies - SUK Manager| UOWNLOanIng SO FLATTOrS AnOrola &6, 3, APl
[2012-82-84 16:11:15 - SDK Manager] Installing SOK Platform Android 4.8.3;, API
[2812-82-84 16:11:56 - SDK Manager] Installed SDK Platform Android 4.8.3, API
[2812-82-84 16:11:59 - SDK Manager] Stopping ADB server succeeded.

[2812-82-84 16:12:083 - SDK Hanagec tarting ADB server STCeagded.

[2012-82-84 16:12:983 - SDK Manager] Done. 3 packages installed.

a n ¥

Notice the message that we have circled in red at the bottom of the screen. You may see more or

less than 3 packages installed based on your choices in the download screen.
Selecting the Android SDK Version

There are many different versions of the Android SDK. Fach version will support a certain version
of the Android operating system. The version that you choose depends on which Android devices

you are targeting with your application.

In our course, we will use Android 2.3.3 (also called “Gingerbread”), which is currently in use on
many of the Android devices on the market. Applications developed against 2.3.3 will also run on
later versions of the operating system! However if you develop against the very latest operating

system (e.g. 4.0) then your applications may not run on existing phones with an earlier OS!

To download and install this version of the Android SDK, we will need to use the Android SDK
Manager from within your Eclipse software. To begin, click on the SDK Manager icon on the
Eclipse toolbar:

-E-doe (@8 84 $-0-a-
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The Android SDK Manager screen will list all of the available Android SDK versions. You will

need to select the version we are using for this course to download and install!

Android 50K Manager E'@

Packages Tools
SDK Path: Chandroid-sdhks!,

Packages

Mame API Rew. Status i

[ Tools ‘
[ Android 4,0.3 (API15)
[ (2] Android 4.0 (4P114)

» [T 12] Android 3.2 (API13)
O G
O
[

| m

Android 3.1 (API12)
Android 3.0 (API11)

10 2 « Not installed
- 10 1 « Not installed
[7] *Re. Google APIs by Google Inc. 10 2 -« Not installed -
Show: [V]Updates/New [¥|Installed [C] Obsolete Select New or Updates [Installl package...D
Sort by: @ APT level () Repository Deselect All Delete packages...
. |

Done loading packages.

First, click on the “Deselect All” option at the bottom of the screen to remove any packages that
were pre-selected. Then find the entry named “Android 2.3.3 (API 10)”. When you expand that
folder, find the box marked “SDK Platform” and then put a check in this box. Then click on
“Install 1 Package”.
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Once you click on “Install 1 Package”, you will see the following summary and licensing screen:

i ™
Choose Packages to Install [ (=] é]

Packages Package Description & License
" 50K Platform Android 2.3.3, API10, ...i Package Description -
Android 5DK Platform 2.3.3._r2 i
Revision 2

m

Archive Description
Archive for any 05

Size: 81.5 MiB i
SHAL: 887 e37783ec32f541 ea33c2cb49d dabdf el ebfb3

-

"I Reject () Accept All

[ Install J Cancel

Click on “Accept” or “Accept All” to agree to the license terms for the SDK and then click on the
“Install” button. The status of the download and installation will then appear at the bottom of the
Android SDK Manager window:

Show: Updates/New [V|Installed | Obsolete Select New or Updates Install 1 package...
() Repository Deselect All Delete packages...
g |

Downloading SDK Platform Android 2.3.3, API10, revision 2 (30%, 324 KiB/s, 3 minutes |eft)

http://www.HomeschoolProgramming.com Page 25



http://www.homeschoolprogramming.com/

Copyright 2012 by Homeschool Programming, Inc.

When the installation is complete, you will see the message “Done loading packages” at the bottom

of the screen and the SDK Platform for Android 2.3.3 will show as “Installed” in the main list:

-

Android SDK Manager I=EN
Packages Tools
SDK Pathe Chandroid-sdksh

Packages
Marne APT Rew.  Status i
4 Tools
I Android SDK Tools 18 fPlnstalled
§ Sndroid 50K Platform-tools 10 S lnstalled
4 [zl Android 4.0.3 (&P115) -
[ | Documentation for Android SOK 15 2 - Not instgited
SDK Platform 15 2 = Installed
[l & Samples for 50K 15 2 w Mot instalted
[] v ARM EAB! v7a System Imags 15 2 w Mot instali=d
[] ® Intel 286 Atom Systerm Imoge 15 1 w Mot instalted
[l Sources for Android 50K 15 2 -« Mot instgited
[C]Z] Andraid 4.0 (AP1 14
[C] =] Android 3.2 (8P 13)
[C]1Z] Andraid 3.1 (AP 12)
[T =] Android 3.0 (&PT 11)
4 [C]1Z] Andraid 2.3.3 (AP 10)
7 % SDK Platform 10 2
D& Samples for 50K I 1 w ot nstaiied -
Show: [V Updates/Mew [VInstalled  [] Obsolete Select Mew ar Updates [ Install 3 packages... ]
Sort by: @ AP level ' Repository Deselect Al [ Delete 3 packages.. ]

. _ ' u

You can click the red “X” in the top-right corner to close this window.

Congratulations, you are now finished installing and configuring the Android SDK! You do not
need to complete any of the further sections in this document under “Manually Installing the

Android Software Development Kit”.
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Manually Installing the Android Software Development Kit

If for any reason, you were not able to complete the automatic download and installation of the

Android SDK in the Eclipse software, you will need to complete this process manually.

Note that these instructions are ONLY needed for those who were not able to install the Android

SDK using the steps in the last section. If you have already installed the Android SDK, please skip

this section!

Since you must enter an existing directory location, and the Android SDK directory does not exist

yet, first run the Windows Explorer program and create the following directories:

C:\android-sdk
C:\android-sdk\tools

-

= = 2

@\;;" J = THO.. » andr.. » '|":F|

SEqQrch ongdroig-sgk p

Organize = = Open Include in library -
i Mame
K Comp
L | tools
|
, android-sdk
. tools
) Curriculum
- 4 1

A .l P 'y

=

4= -

-~

1 @

To create a new directory in Windows Explorer, right-click on the parent directory such as “C:” and

select “New Folder”, and then type in the new folder name. Repeat the process by selecting the

“android-sdk” folder and adding a “tools” sub-folder name.

directory structure should match the above image.

When you are done your empty

http:
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Next, you will need to set the install location of the Android ADK. To do this, from the Eclipse

menu select Window = Preferences = Android.

When you first click on the
Android area, you may get a pop-

up from Google about usage Thanks for using the Android SDK!

statistics. You can un-check the We know you just want to get started but please read this first.
. By choosing to send certain usage statistics to Google, you can help us improve

box and click Proceed Y g d giey P P

You can now enter the location
for your Android SDK files in the

(= [

the Android SDK. These usage statistics lets us measure things like active usage of
the SDK, and let us know things like which versions of the SDK are in use and
which tools are the most popular with developers. This limited data is not
associated with personal infermation about you, and is examined on an

| |'Send usage statistics to Google:

If you [aterderd ge this setting, you can do so in the"ddms" tool under

»

"File" > "Preferences” > "Usage Stats".

“SDK Location” area on the right side of the screen. Type in “c:\android-sdk” and click “Apply”.

type filter text

Lint Error Checking
LogCat

Usage Stats
Ant
Help
Install/Update

lava

Android

Android Preferenc

chandroid-sdk Browse... |

Mote: The list of SDK Targets below is only reloaded once you hit 'Apply’ or 'O

Target Mame Vendor Platforrm  APL..

== Mo target available == ==

@
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When you click “Apply”, you may get one or more pop-up messages indicating you are missing
some Android SDK components (and you are, this is what we’re installing manually!). Click the

“Open SDK Manager” button to continue.

; T T
2 Android SDK Verification X
k SDK Platform Tools component is missing!
/ l . Please use the SDK Manager to install it. !
Open 50K Manager Close ]

You can also select “Window = Android SDK Manager” from the Eclipse menu if you close these
pop-ups accidentally.

Now, click “Deselect All” to clear any prior selections, and then drill down until you can check the
“SDK Platform” for the “Android 2.3.3 (API 10)” element. Then click “Install 1 package...”.

-

-

Android SDK Manager = | = A

Packages Tools
SDK Path: chandroid-sdk,

Packages

Mame API Rev.  Status
[ Tools
[] (=] Android 4.0.3 [API15)
[T (2] Android 4.0 [APT14)
[T (2] Android 3.2 (API13]
[ (2] Android 3.1 [API12)
[] (=] Android 3.0 (API11)
4 [7]£] Android 2.3.3 (API10)

[ | »

EDK Platform 10 P & Mot installed
[ ¢y Samples for SDK 10 1 + Net installed -
' T | r

—
Show: [¥|Updates/Mew [V|Installed || Obsolete Select New or Updates (nstall 1 package...P
Sort by: @ API level (2 Repository Deselect All Delete packages...

Done loading packages.
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On the license screen, select “Accept all” and then click “Install”.

Choose Packages to Install

Packages Package Description & License
s~ Android SDK Tools, revision 19 [*] Package Description
~ Android SDK Platform-tools, revision 11 [*] Android SDK Teols, revision 19

SDK Platform Android 2.3.3, AP110, revisio Dependenci
Installing this package also requires installing:
- Android SDK Platform-tools, revision 11

This package is a dependency for:
- SDK Platform Android 2.3.3, AP110, revision 2

Archive Description

Arrbinem Foe VAR m Amavar

() Accept () Reject @ Accept All

@
’ T

[*] Something depends on this package [ Install ] Cancel l

At this point, the SDK will be downloaded from the Internet and installed on your computer. This
process can take anywhere from a few minutes to 10 minutes or more, depending on the speed of

your Internet connection.

Show: [¥|Updates/Mew [V/|Installed || Obsolete Select New or Updates Install 1 package...

Sort by: @ API level (2 Repository Deselect All Delete packages...

A —— :
. . ” |
Installing SDK Platform Android 2.3.3, API10, revision 2

NOTE: If you wish to develop for Android 4.0.3 or other operating system versions, you can
repeat this process and also install those SDKs.
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Once the progress bar dialog disappears, you will see “Done loading packages” at

the bottom of the

Android SDK Manager, and the word “Installed” next to the three major packages that were

downloaded. You can now close the Android SDK Manager window.

-

Android SDK Manager

Packages Tools
SDK Path: chandroid-sdk,

Packages
Marmne API Rev.
[ X Android SDK Tools 19 [ S Installed
[T] "% Android SDK Platform-tools 11 N JInstalled

[]£) Android 4.0.3 (API15)
[]() Android 4.0 (APT14)
[](=) Android 3.2 (API13)
[](z) Android 3.1 (API132)
[]() Android 3.0 (API11)

[]£) Andreid 2.3.3 (API10)
[ 50K Platform 10 2 |3 Installed

[ | »

' 1 S P

| 3

Show: Updates/Mew Installed  [| Obsolete Select Mew or Updates

Install packages...

Sort b]l": ':!é:' APT level ':.:.:' REPDSitDr}f Deselect All Delete ﬁEEkEgEE...
'lf}F loadi k > 3
(Jne oading packages.

Congratulations, you are now finished installing and configuring the Android SDK!

http://www.HomeschoolProgramming.com

Page 31



http://www.homeschoolprogramming.com/

	Download and Installation Instructions
	for
	Android SDK and Android Development Tools (ADT)
	on
	Microsoft Windows
	Let’s Get Started!
	Downloading the Original Course Android Bundles
	Installing the Eclipse ADT Version 16
	Configuring the Android SDK after Restart
	Configuring the Android SDK Location Manually

	Installing the Latest Android Versions (Alternative Procedure)
	Downloading and Installing the Android Development Tools
	Downloading and Installing the Android SDK
	Selecting the Android SDK Version
	Manually Installing the Android Software Development Kit


